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Comment:
Optional commands are written as

[Command] resp. [<Command>]

1. First Steps

1.1. Purpose of WindowsPE

Windows PE (Windows PreinstallationEnvironment) is excellent suitable for following range of
applications:

Repairing Computers

Performing Data Recovery

Preparing a reinstallation of Operating System
Removing a virus

Rebuilding private data (documents and pictures)
Restoration of images files

33332338

Back to Table of Contents

1.2. Building WindowsPE

Video manual in forum LiveSystem-pro.de:
http://www.livesystem-pro.de/showthread.php?92-Videoanleitung-1-quot-LiveSystem-pro-quot-PE-Builder

Back to Table of Contents

1.3. Supported Host Computer Systems

At moment following systems will be supported:

= Windows XP/2003 ServicePack 3 (32/64-bit)

= Windows Vista with all ServicePacks (32/64-bit)
= Windows 7 with all ServicePacks (32/64-bit)
= Windows 8/8.1 (32/64-bit w/o ServicePack)

Back to Table of Contents

1.4. Supported PE Systems

LiveSystempro is available with 3 projects:

= WinXPE Windows XP, Windows 2003

= Multi7PE_SE Windows Vista (32/64-bit)*, Windows 2008 (32/64-bit)*, Windows 7 (32/64-bit)*,
Windows 2010 (32/64-bit)*

= Win8PE Windows 8 (32/64-bit), Windows 8.1 (32/64-bit), Windows 2010 R2 (32/64-bit),

Windows 8.1 Update 1 (32/64-bit)
* = all ServicePacks
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2.1.

All of them are integrated in LiveSystempro and selectable separately.

Back to Table of Contents

Syntax of Commands

System

Convert

Converts decimal and hexadecimal values

Syntax:
Convert,<%Variable%>,<Method>,<Value>

Method: - Hex2Dec converts a hexadecimal value into a decimal one
Dec2Hex converts a decimal value intp a hexadecimal one
Dec2chr converts a decimal value into Ascii code

(Unicode will be supported)
Examples:

Convert,%Var%,Hex2Dec,401a
Allocates to variable %Var% the value 16410 .

Convert,%Var%,Dec2Hex,16410
Allocates to variable %Var% the value 401la .

Convert,%Var%,Dec2chr,65
Allocates to variable %Var% the value A .

Back to Table of Contents

Echo

Shows an information

Syntax:
Echo,<Text>

Example:
Echo,Running script

Back to Table of Contents

Exit
Quits the running script

Syntax:
Exit

Example:
If,%Arch%,=,x64,Then,Exit
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Back to Table of Contents

Halt

Stops accomplishment of build

Syntax:
Halt,[<Text>]

Text - any text (optionally)

Example:
Halt,Aborted by user

Back to Table of Contents

Math

Performs a mathematic counting

Syntax:
Math,<%Variable%>,<Value>,[<PARAMETER>]

%Variable% - any name

Value - mathematic counting

Parameter (optional) - Round_Up / Round_Down
Examples:

Math,%NewVar%,45+(7*4)
Allocates to variable %NewVar% the value of 73 (sum of 45 + 28)

Math,%NewVar%,16.9-10,Round_Down
Allocates to variable %NewVar% thevalue of 6 in round terms

Back to Table of Contents

Message
Shows a message box

Syntax:
Message,<Text>,[<Title>],[<Timeout>]

Text - Text in message box

Title - Title of message box
Information shows symbol Information
Confirmation shows symbol Question mark
Error shows symbol Error
Question shows a button YES/NO
Warning shows symbol Warning

Timeout - Display duration of box in seconds

Examples:
Message,Hallo World,Information,10

Message,Continue?,Question

If,%Exitcode%,=,Yes, Then,Message,Button YES has been pressed
If,%Exitcode%,=,No,Then,Message,Button NO has been pressed

Back to Table of Contents
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Pack

Compresses or decompresses a file

Syntax:
Pack,<Packcommand>,[<Filter>]

Packcommand - Compress for files with extension ,.zip’ only
Decompress for files with extension ,.zip’ and ,72’
Filter - available for Packcommand DECOMPRESS only.

Using the char * the filter changes to partial search
(similar to a Wildcard function)

Examples:
pack,compress,C:\Test,C:\Test.zip
Compresses the folder Test to ZIP file Test.zip.

pack,decompress,C:\RegConfig.7z,C:\MyFolder,Win8x86 productoptions.reg
Decompresses from 7z file RegConfig.7z file Win8x86 and productoptions.reg.

pack,decompress,C:\Test.7z,C:\Test,*.pdf
Decompresses from 7z-file Test.7z all files with extension pdf.

Back to Table of Contents

Return

Quits the called section of a script

Syntax:

Return

Example:
Run,%ScriptFile%,MySection
Message,%Arch%
[MySection]
If,%Arch%,=,x64,Then,Return
Message,Fitting architecture

The message box Fitting architecture is available with Architecture x86 only.

Back to Table of Contents

Run
Performs a section in the specified script

Syntax:
Run,<%ScriptFile%>,<Section>,[<PARAMETER>]

%ScriptFile% - a. Full path of script
b. Calling a section in the running script typing
%ScriptFile% is enough
Section - Section to perform in script
PARAMETER - 9 Parameters to commit (#1 up to #9)
Example:

Run,%ScriptFile%,MySection,Hallo
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[MySection]
Message,#1,Information

In this example a message box will appear with text Hallo.

Back to Table of Contents

Set

Allocates a value to a Variable

Syntax:
Set,<%Variable%>,<Value>,[PERMANENT]

Value - any value or path
PERMANENT - valid for the whole build, stored in project.cfg
in section [variables]

Examples:
Set,%NewVar%,myPE
Allocates to variable %NewVar% the value myPE .

Set,%NewVar%,myPE,PERMANENT
Allocates to variable %NewVar% the value myPE , valid for the whole build.

Back to Table of Contents

Setmacro
Creates a macro

Syntax:
Setmacro,<Macroname>,<Command>,[PERMANENT]

Macroname - any name without %%
Command - any valid build command
PERMANENT - valid for the whole build, stored in project.cfg

in section [Macros]

Example:
Setmacro,require_file,Run,%ProjectDir%\Macro.srt,Process-ReqSys32,#1,PERMANENT
Creates the macro require_file with command
Run,%ProjectDir%\Macro.srt,Process-ReqSys32,#1,PERMANENT

Back to Table of Contents

SetMvar

Creates a macrovariable

Syntax:
SetMvar,<%Variable%>,<Value>

Example:

SetMvar,%MyVariable%,myPE

Creates a macrovariable with value myPE.

The macrovariable is valid in running script only!

Back to Table of Contents
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SYSTEM

Command for System settings

Syntax:

System,<Systemcommand>,<Systemparameter>,[<Section>]

Systemcommand: Error Enables / Disables error messages

FreeRam Shows free RAM
TotalRam Shows total RAM
GetEnv reads Environment Variables

Temp

ProgramFiles

Number_Of Processors
GetFreeDrive Shows the next free available

Drive Letter

GetFreeSpace Shows the available free Space
GetDriveType Shows medium’s type
Log Enables / deactivates writing of LOG file
ProcessMode Launches the GUI in Process mode
SetPEinit Calls a free number from Peinit.ini

Systemcommand (x64 systems only):
FileRedirect Turns FileRedirection (Wow64) for

64-bit systems on or off

Turns RegRedirection (Wow64) for

64-bit systems on or off

RegRedirect

Systemparameter: concerning Error On | Off
concerning FileRedirect On | Off
concerning FreeRam %\Variable%
concerning TotalRam %\Variable%
concerning GetFreeDrive %Variable%
concerning GetFreeSpace %Variable%
concerning GetDriveType Return value
1- no Root
2- portable Device
3- Harddisk
5- CDROM
concerning SetPEinit %Variable%,[<Section>]
concerning Log On | Off
Log,On,1 Enables writing of LOG file and
deletes an existing LOG file
concerning RegRedirect 64 | Off
Section: concerning GETFREEPEInitNo
Examples:

System,FILEREDIRECT,On
System,FILEREDIRECT,Off
System,REGREDIRECT,64
System,REGREDIRECT,Off
System,GETFREEDRIVE,%FreelLetter%
Allocates to variable %Freeletter% the next available free drive letter.
System,GETFREESPACE,%Drive%,%Size%
Example:
Set, % Txt%,
For,%Var%,65,90
Convert,%Drive%,Dec2chr,%Var%
System,GetFreeSpace,%Drive%:\,%Size%
If,%Size%,>,0,Then,Set, % Txt%,%Txt% %Drive% - %Size%#$x
Next
String,%Txt%, TRight,%Txt%,2
Allocates to ariable %Txt% all partitions with current free space.
Notation:
65 and 90 are the ASCII values of letters A and Z.
System,GETDRIVETYPE,%Drive%,%Type%
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Example:
Set, % Txt%,
For,%Var%,65,90
Convert,%Drive%,Dec2chr,%Var%
System,GetDriveType,%Drive%:\,%Type%
If,%Type%,=,3,Then
System,GetFreeSpace,%Drive%:\,%Size%
If,%Size%,>,0,Then,Set,%Txt%,%Txt% %Drive% - %Size% MB#$x
End
Next
String,%Txt%, TRight,%Txt%,2
Allocates to variable %Txt% the free space of the chosen type.
System,GetEnv,%Var%,ProgramFiles
Allocates to variable %Var% the full path of %ProgramFiles%.
System,GetEnv,%Var%, Temp
Allocates to variable %Var% the full path of folder %Temp%.
(e.g..: C:\Users\<Username>\AppData\Local\Temp
System,GetEnv,%Var%,Number_Of_Processors
Allocates to variable %Var% the number of processors
System,SetPElnit,<ID>,<Section>,<Command>
Looks for an available free number in PEInit.ini and writes the entry and the command.

-ID Entry ID (chars or digits)
Valid in sript only
- Section either Init or Startup

Syntax example:

System,SetPElnit, A, Init, RunWait|%PE_programs%\%Programfolder\ProgramEXE% %Param%
Definite example:

System, SetPElnit,A,Init,RunWait|%PE_programs%\Drvimp\Drvimpe.exe —d —i:"%UFD%\Drivers\%Archit%”
Writes in PEInit.ini e.g. these entries:

[Init]

20=RunWait|X:\Programme\Drvimp\Drvimpe.exe —d —i:"%UFD%\Drivers\%Archit%

[Init-1D]

20=A,Apps\my — Driver Import PE\Drvimpe.srt

The file Peinit.ini defines which commands will be executed starting PE.
The range of commands reaches from 001 up to 049, whereas 001 up to 015 are
reserved for the respective project.

Examples (WinXPE):

[Init]

003=Ramdisk|25|%]|imdisk.exe -a -t vm -m B: -s %Rsize%M -p "/fs:NTFS /q /y /v:Imdisk"

004=CMD|md "B:\Documents and Settings\Default User\Local Settings\Temp"

006=DllInstall|shell32.dlIl

007=DllInstall|browseui.dll

008=DllInstall|shdocvw.dll

039=BROADCAST

016=RunWait|reg.exe add HKLM\SYSTEM\CurrentControlSet\Services\usbhub /v ImagePath /t REG_EXPAND_SZ
/d system32\DRIVERS\usbhub.sys /f

The numbers don't have to be arranged continuously, but existing numbers will be
overwritten by identical numbers.

Command list peinit.exe:
CMD runs a DOS command
Example:
CMD|md #$q%RamDrive%\%doc_and_sett%\Default User\%local_sett%\Temp#$q
Dllinstall installs a DLL file
Example:
Dllinstall|shell32.dII
Register registers a DLL file
Example:
Register|shell32.dll
Ramdisk creates a RamDisk
Example:
Ramdisk|%pTextBox1%]|%pScroliBox1%|imdisk.exe -a -t vm —m %RamDrive% -s %
Rsize%M —p#$q/fs:%Format% /q ly Iv:%pTextBox2%#$q
Value of %pScrollBox1%: % or MB
DrvLetter changes the drive letter
Example:
DrvLetter|%CDDrive%]|1386\%ImageFile%
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Run runs a program
Example:
Run|imdisk.exe -a -t vm -m %RamDrive% -s %Rsize%M -p #$q/fs:%Format% /q ly
IV:%pTextBox2%#$q
Runwait runs a program and waits for its end
Example:
Runwait|imdisk.exe -a -t vm -m %RamDrive% -s %Rsize%M -p #$q/fs:%Format% /q ly
IV:%pTextBox2%#$q
BROADCAST  refreshes the environment variables
Example:
BROADCAST
SetRes changes the screen resolution
Example:
SetRes|1024|768
StartService starts a service
Example:
StartService|Ext2fs|IfsDrives
multiple specifications are possible (separated by |)
RegWrite writes a Registry value
Example:
RegWrite|HKLM|0x1|SYSTEM\ControlSet001|key|ka#$-dre ;'$-d ="|"
For special chars you have to use the keyword $-d ="|"

Location of Peinit.ini:
Multi7PE_SE:  X:\Windows\System32
WinXPE: X:\I386\SYSTEM32
Win8PE: X:\Windows\System32

Back to Table of Contents

Wait
Pauses the script by the specified milliseconds

Syntax:
Wait,<Milliseconds>

Example:
Wait,1000

(1 second = 1000 milliseconds)

Back to Table of Contents

Wim Commands
Commands processing Image files

Syntax:
Wim,<Command>

Available commands: Wim,create
Wim,info <,Path to Image>
Wim,infoEdition <,Path to Image>
Wim,Extract,File <,Path to Image>
Wim,Extract,Image <,Path to Image>
Wim,Extract,FileList <,Path to Image>
Wim,Extract,Image <,Path to Image>

Path to Image:
Win8PE: - Usage of var %lnstallwim% (compare section 2.9)
Multi7PE_SE: - Usage of %SourceDir%\sources\xyz.wim
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Examples:
Wim,Create,lzms,%TargetDir%,%Target_CD%\sources\Boot.wim
Compresses Boot.wim using compression method Izms.

Wim,info,%SourceDir%\sources\install.wim,%WIM_Index%,%ProjectDir\project.cfg
Reads the WIM Index from install.wim and writes it in project.cfg.

Wim,infoEdition,,%SourceDir%\sources\install.wim,pScrollBox1,%ProjectDir%\Build\0-PreConfig.srt
Writes the Source Edition in file 0-PreConfig.srt.

Wim,Extract,File,%SourceDir%\sources\install.wim,%WIM_Index%,#1,%InstallSRC%
Extracts the file with parameter #1 to %lInstallSRC%.

Wim,Extract,Image,%SourceDir%\sources\install.wim,%WIM_Index%,#1,%InstallSRC%
Extracts the content of a determined WIM Index from Install.wim to %lnstallSRC%.

Wim,Extract,FileList,%SourceDir¥%\Sources\Install.wim,%WIM_Index%,%ProjectTemp%!\Instwim.txt,%Basedir%\Wim\%0S%%SourceE
dition%%arch%%SP%%Distlang%-N\%WIM_Index%
Extracts to the target directory files based on the content of Instwim.txt.

Wim,Extract,Image,f:\boot.wim,f:\test5\
Extracts boot.wim to directory test5.

zuriick zum Inhaltsverzeichnis

Update

Refreshes the variable data memory

Syntax:
Update,<Parameter>,[ScriptDir]

Parameter: ProjectVar all variables from project.cfg, section [variables] will be
loaded into the variable data memory
InterfaceVar variables from section [Interface] of any script will be
loaded into the variable data memory
Project all scripts will be loaded again
Project,ScriptDir script directory will be loaded again
Examples:

Update,ProjectVar

Update,InterfaceVar

Update,Project
Update,Project,Apps\%pTextBox111%.srt

Back to Table of Contents

2.2. Programmable Conditions (If Conditions)

If,...,Then

Syntax:
If, <Condition>,Then,<Command>

Negative Syntax:
If,Not,<Condition>,Then,<Command>

Available Conditions: ExeRunning
ExistFile
ExistDir
ExistSection
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ExistRegKey
ExistWebFile
SrtChecked
(equal)
(smaller)
(bigger)

VvV Al

Examples:
If,%Var%,=,1,Then,Message,Value is equal 1
This message will be shown only if value of %Var% is equal 1.

If,3,>,2,Then,Message,3 is bigger than 2
This message will be shown always as 3 is bigger than 2.

If,ExistFile,%ScriptDir%\test.exe, Then,Message,File does exist
This message will be shown only if test.exe does exist.

If,ExistDir,C:\Programs, Then,Message,Directory does exist
This message will be shown only if directory C:\Programs does exist.

If,Not,ExistDir,C:\Intel, Then,Message,Directory does not exist
This message will be shown if directory C:\Intel does NOT exist.

If, ExistRegKey,HKLM,PE-SYSTEM\ControlSet001\Services\i8042prt\Parameters,EnableWheelDetection, Then,Message,Value exists
This message will be shown if value EnableWheelDetection does exist in mentioned key.

If,ExistSection,%target_win%\TXTSETUP.SIF,SourceDiskFiles, Then,Message,Section does exist
This message will be shown if section SourceDiskFiles does exist in file TXTSETUP.SIF .

If ExistRegKey,HKLM,PE-SYSTEM\ControlSet001\Services\i8042prt\Parameters, Then,Message,Key exists
This message will be shown if the complete RegKey does exist.

If, EXISTREGKEY,HKLM,PE-SYSTEM\ControlSet001\Services\i8042prt\Parameters,, Then,Message,exists
This message will be shown if value (Default) does exist in mentioned key.

If, SrtChecked,Build\8-HW-pnp.srt,Then,Message,Script is enabled
This condition prooves if the script has been enabled.

If, ExistWebFile,http://www.xyz.com/xyz.zip, Then,Message,File is available
This message will be shown only if xyz.zip is available.

If, ExeRunning,vmware.exe, Then,Message,VMware is already running
This message will be shown only if VMware is already running.

Tip to multiline notation:
This notation is also possible:

If,%Var%,=,1,Then
Message,Value is 1
End

Using this notation the command END is ALWAYS necessary !

Back to Table of Contents

If,...,Then,...,Else-Block

All above mentioned conditions can also be used as EITHER — OR Block

Syntax:
If, <Condition>,Then
<Command_#1>
Else
<Command_#2>
End
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2.3.

2.3.1.

Examples:
If,ExistDir,C:\Intel, Then
Message,Directory does exist
Else
Message,Directory does not exist
End

This condition shows either the first or the second message depending on the result.

If,%Var%,=,1,Then

Message,Value is equal 1
Else

Message,Value is not equal 1
End
Same result as written above.

Combination with NOT is also possible.
Example:
If,Not,%Var%,=,1,Then

Message,Value is unequal 1
Else

Message,Value is equal 1
End

Back to Table of Contents

Conditions for Directories, Files and Interfaces

Directories

DirCopy
Copies the content of a folder into another folder

Syntax:
DirCopy,<SourceFolder>,<TargetFolder>

Example:

DirCopy,C:\MyFolderC:\MyOtherFolder

Copies the content of C:\MyFolder to C:\MyOtherFolder.
If the targetfolder does not exist it will be created.

Back to Table of Contents

DirRemove
Deletes a directory

Syntax:
DirRemove,<FolderToDelete>,[recursive]

Recursive: 1 deletes folders and subfolders

0 default value, deletes only the subfolders

Examples:
DirRemove,C:\MyFolder,1
Deletes the folder C:\MyFolder and all subfolders.

DirRemove,C:\MyFolder\MySubfolder,0
Deletes only the subfolder MySubfolder.
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2.3.2.

Possible syntax if no subfolder does exist:
DirRemove,C:\MyFolder,0

Back to Table of Contents

DirMove
Moves a directory

Syntax:
DirMove,<FolderToMove>,<TargetFolder>

Example:

DirMove,C:\MyFolder,C:\MyOtherFolder

Moves the content of C:\MyFolder to C:\MyOtherFolder.
The origin folder will be deleted.

Back to Table of Contents

DirMake

Creates a folder

Syntax:
DirMake,<NewFolder>

Example:
DirMake,C:\MyFolder
Creates the new folder C:\MyFolder.

Back to Table of Contents

Files

2.3.2.1. Conditions for Files

FileCopy
Copies a single source file to a specified destination

Syntax:
FileCopy,<SourceFile>,<TargetFolder>

Example:
FileCopy,C:\MyFolder\MyFile.txt,C:\MyOtherFolder

Copies the file MyFile.txt from C:\MyFolder to C:\MyOtherFolder.

Wildcards (*.*) are supported.

Back to Table of Contents

FileDelete
Deletes a single file

Syntax:
FileDelete,<File>
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Example:
FileDelete,C:\MyFolder\MyFiletxt
Deletes the specified file.

Back to Table of Contents

FileRename
Renames an existing file

Syntax:
FileRename,<OldFilename>,<NewFilename>

Example:
FileRename,C:\MyFolder\MyFile.txt,C:\MyFolder\MyNewFile.txt
Renames the file MyFile.txt to MyNewFile.txt

Back to Table of Contents

FileCreateBlank

Creates an empty file (an existing same-titled file will be deleted)

Syntax:
FileCreateBlank,<NewFile>,[<CharacterSet>]

CharacterSet (optional) - ANSI
Unicode
UTF-8
Examples:

FileCreateBlank,C:\MyFolder\test.txt
Creates in the specified folder the empty file test.txt

FileCreateBlank,C:\MyFolder\test.txt,utf8
Creates in the specified folder the empty file test.txt with charset UTF-8

Back to Table of Contents

FileRead

Reads the whole content of a file into a variable

Syntax:
FileRead,<%Variable%,<File>,[Counter]

Counter: - optional parameter (number of chars to read)

Examples:
FileRead,%Var%,C:\MyFolder\test.txt
Reads the whole content of test.txt into variable %Var%.

FileRead,%Var%,C:\MyFolder\test.txt,20
Reads 20 chars of the content of test.txt into variable %Var%.

Possible action when cursor is placed undesired at the begin of a blank line:
(%Var%=C:\MyFolder\test.txt)

String,%Result%,RIGHT,%Var%,2

If,%Result%,=,#$x,Then,String,%Var%, TRIGHT,%Var%,2

Sets the cursor next to the last existing char.
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Back to Table of Contents

FileSetAttrib

Changes attributes of a file

Syntax:

FileSetAttrib,<File>,<Attribute>,[<Parameter>]
Available Attributes: ReadOnly
Archive
System
Hidden
Normal
Offline
Temporary

- 0ZITwnw>rx

[anY

Parameter: Recursive
Using Wildcards (*) is possible.
Attributes will be changed by using + or —

Examples:
FileSetAttrib,C:\MyFolder\test.exe,+RS
FileSetAttrib,C:\MyFolder\*.doc,+RS
FileSetAttrib,C:\MyFolder\*.doc,-H

FileSetAttrib,C:\MyFolder\,+H
Changes the attribute of a single folder.

FileSetAttrib,C:\MyFolder\,+H,1
Changes the attribute of a folder with all included subfolders.

Back to Table of Contents

CopyFile

Copies a file from Sourcefolder to Targetfolder.
This command is suitable for projects Multi7PE_SE and Win8PE.
Note:
The command SetReqFile has to be used previously to define directories and parameters

Syntax:
CopyFile,<File>,[Mode]

Modus 0 - ohne .mui-Datei
1 - mit .mui-Datei + Fallback en-US (en-US-Ersatzfunktion)

Example:

SetReqFile, %6boot _sys%, %6DistLang %, %target _sys%
CopyFile,drivers\acpi.sys,1

CopyFile, atmlib.dll

Copies the file drivers\acpi.sys to %target_sys%.

Copies the file drivers\acpi.sys.mui to %target_sys%\%DistLang%.
Copies the file atmlib.dll to %target_sys%.

Back to Table of Contents

CopyOrExpand
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Copies a file and expands it if neseccary

Syntax:
CopyOrExpand,<File>,<TargetfolderOrTargetname>

Example:
CopyOrExpand,C:\MyFolder\MyFile.txt,C:\MyFolder\MyNewFile.txt

In this example CopyOrExpand will first try to copy C:\MyFolder\MyFile.txt.
If the file can’t be found then CopyOrExpand will try to expand
C:\MyFoldenMyFile.tx_ .

Back to Table of Contents

Expand
Extracts all files inside a CAB file

Syntax:
Expand,<CAB_File>,<TargetFolder>,[<Filter>]

Filter Expands a single file or multiple files, separated using char :
The Targetfolder has to exist and will NOT be created automatically.
Examples:

Expand,C:\MyFolder\MyFile.cab,C:\MyNewFolder
Extracts all files inside MyFile.cab to C:\MyNewFolder.

Expand, %6source_sys%6\%SPCabFile%, %target _sys%o\drivers,aec.sys:agp440.sys
Extracts in Project WinXPE from CAB file (e.g.: SP3.cab) the files
aec.sys and agp440.sys to %target sys%ldrivers.

Expand, %6source_sys%6\%SPCabFile%, %target _sys%
Extracts in Project WinXPE from CAB file (e.g.: SP3.cab) the file
bther.dllto %target sys%.

Back to Table of Contents

ReqFile

Verifies if the file already exists in target. If not so the file will be copied from Sourcefolder to Targetfolder.
This command is suitable for projects Multi7PE_SE and Win8PE.
Note:

The command SetRegFile has to be used previously to define directories and parameters

Syntax:
ReqgFile,<File>,[Mode]

Mode 0 - no .mui file
1 - with .mui file + Fallback en-US

Example:

SetReqFile, %Install_sys%6, %6DistLang%, %target _sys%
RegFile,accessibilitycpl.dll,1

RegFile,control.exe

Copies the file accessibilitycpl.dll to %target_sys%.

Copies the file accessibilitycpl.dll.mui to %target_sys%\%DistLang%
Copies the file control.exe to %target_sys%.

Back to Table of Contents
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Require_File

Verifies if the file already exists in target. If not so the file will be copied from Sourcefolder to Targetfolder.
This command is used in project WinXPE.

Syntax:

Require_File,<File>

Example:

Require_File,shell32.dll

Copies the file shell32.dll to %target_sys%.

Back to Table of Contents

Retrieve
Query of special file informations

Syntax:
Retrieve,<%Variable%,<Parameter>,<FolderOrFile>,[Param2],[Param3]

Parameter - DirSize
FileSize
FileVersion
MD5
ResStr (Resources string)
FileArch (for EXE files only)
ResStr only: Param2 optional [shows LCID (locale identifiers)]
Param3 optional [shows resource number]
Examples:

Retrieve,%Var%,DirSize,C:\MyFolder
Allocates to variable %Var% the size of MyFolder .

Retrieve,%Var%,FileArch,C:\Windows\explorer.exe
Allocates to variable %Var% the architecture of explorer.exe .
ONLY EXE files are supported.

Retrieve,%Var%,MD5,C:\boot.ini
Allocates to variable %Var% the MD5 sum of file boot.ini .

Retrieve,%Var%,ResStr,C:\Windows\system32\shell32.dll, 00000409,21771
Allocates to variable %Var% the value Documents and Settings .

Back to Table of Contents

Search File
Searches for a file. Wildcards are supported

Syntax:
Search,<%Variable%>,<Parameter>,<Directory>,<Filename>

Parameter - File searches in chosen directory for files with same
file extension
FileRec recursive search for maximum 2000 files
Beispiel:

[Interface.07]
pScrollBox3=,1,0,0,20,270,215,20
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[Script-Select]

search,%Var%,File,%ISODir%,*.iso

Interface,set,pScrollBox3,%Var%

Searches for an existing chosen file in %ISODir% and updates the element
pScrollBox3 e.g. with following line:

[Interface.07]
pScrollBox3=Win7[SP0]_de-DE_x86.is0,1,0,0,20,270,215,20,Win7[SP0]_de-DE_x86.iso

Back to Table of Contents

SetRegFile

Defines the directories and parameters for commands Copyfile and Reqfile

Syntax:
SetReqFile,<SourceFolder>,%DistLang%,<TargetFolder>

SourceFolder - any folder

%DistLang% - Directory in System32 with localized language file (MUI)
TargetFolder - any folder

Example:

SetReqFile,%boot_sys%,%DistLang%,%target_sys%
Defines %boot_sys% as source folder and %target_sys% as target folder.

(See also the explanations of commands Copyfile and Reqfile)

Back to Table of Contents

ShellExecute
Starts a program or a file

Syntax:
ShellExecute,<Action>,<File>,[Parameter],[WorkingDir]

Action - Show/Open Process will be shown
Hide Process will be hidden

Parameter - optional set of switches

WorkingDir - optional

Examples:

ShellExecute,Show,C:\Windows\system32\cmd.exe
This command opens a console window.

Note:

The command ShellExecute in a script effects the script to wait for the end of the launched
file / program. Afterwards the remaining lines in script will be executed.

Back to Table of Contents

Start

Starts a program without waiting

Syntax:
Start,<File>,[Parameter],[WorkingDir]
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Example:
Start,%Windowsdir%\Notepad.exe,%ScriptFile%,%WindowsDir%
This command opens the running script with program Notepad.

Back to Table of Contents

2.3.2.2. Word Processing

TXTAddLine

Adds a line inside a file

Syntax:
TXTAddLine,<File>,<Text>,<Parameter>

Parameter - Top adds line as first line
Bottom adds line as last line
Line number (first line = 0)
Example:

TXTAddLine,C:\MyFile.txt,My new Line,Top
Adds to MyFile.txt the line My new Line as first line.
If the file does not exist it will be created.

Back to Table of Contents

TXTReplace

Renames an existing text

Syntax:
TXTReplace,<File>,<OldText>,<NewText>

Example:

TXTReplace,C:\MyFile.txt,My old Line,My new Line
Replaces in MyFile.txt the line My old Line by My new Line.
If the file does not exist an empty file will be created.

Back to Table of Contents

StrFormat
Returns some parts of a path name

Syntax:
StrFormat,<%Variable%>,<Parameter>,<File>

Parameter - FILENAME File name
PATH File path
EXT File extension

SHORTPATH Path in format DOS 8.3
Examples:
StrFormat,%Var%,FILENAME,C:\boot.ini
Allocates to variable %Var% the value boot.ini .

StrFormat,%Var%,PATH,C:\boot.ini
Allocates to variable %Var% the value C: .
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StrFormat,%Var%,EXT,C:\boot.ini
Allocates to variable %Var% the value ini .

StrFormat,%Var%,SHORTPATH,C:\MyNewFile.txt

Allocates to variable %Var% the value C:\MYNEWF~1.TXT as far as the file does exist.

Back to Table of Contents

2.3.2.3. INI Processing

INniWrite

Writes a value in a section of an INI file

Syntax:
IniWrite,<File>,<Section>,<Key>,<Value>

Example:
IniWrite,C:\LiveSystempro\LiveSyspro.ini,Main,Project,Multi7PE_SE
Creates in file LiveSyspro.ini in section [Main] the entry Project=Multi7PE_SE

Back to Table of Contents

IniWriteSection

Creates a new section in an INI file with optional text settings.
Entries will be written one below the other.

Syntax:
IniWriteSection,<File>,<Section>,[Text]

Examples:
IniWriteSection,C:\LiveSystempro\LiveSyspro.ini,NewSection,

Creates in file LiveSyspro.ini the section [NewSection].

The final comma is an optional comma, thus this notation is also possible:
IniWriteSection,C:\LiveSystempro\LiveSyspro.ini,NewSection
IniWriteSection,C:\LiveSystempro\LiveSyspro.ini,NewSection,MyKey

Creates in file LiveSyspro.ini the section [NewSection] with entry

MyKey.

If the INI file does not exist it will be created.

Back to Table of Contents

IniDeleteSection
Deletes an existing section inside an INI file

Syntax:
IniDeleteSection,<File>,<Section>

Example:
IniDeleteSection,C:\LiveSystempro\LiveSyspro.ini,NewSection
Deletes in file LiveSyspro.ini the section NewSection.

Back to Table of Contents

Seite 22 von 40



IniRead
Reads the value of a key from a section inside an INI file

Syntax:
IniRead,<%Variable%>,<File>,<Section>,<Key>

Example:
IniRead,%Var%,C:\LiveSystempro\LiveSyspro.ini,Main,Project
Allocates to variable %Var% the value of Project .

Back to Table of Contents

IniReadPos
Reads either the value of a key or the key of a value

Syntax:
IniReadPos,<%Variable%> <File>,<Section>,<Parameter>,<Position>

Parameter Count reads the number of defined entries in an INI file
KeyPos reads the Key in a defined line (Result=Value)
Value reads the Value (Result=Key)
ValuePos reads the Value in a defined line (Result=Key)

Position line number (ValuePos and KeyPos only)

Examples:

IniReadPos,%Var%,C:\MyFile.ini,MySection,Value,1
Allocates to variable %Var% the Key whose value is 1 .

IniReadPos,%Var%,C:\MyFile.ini,MySection,ValuePos,2
Allocates to variable %Var% the Key from line 2 .

IniReadPos,%Var%,C:\MyFile.ini,MySection,KeyPos,2
Allocates to variable %Var% the Value of key from line 2 .

INI file C:\Lang.ini with following content:
[Section]
Key_1=german
Key_2=English
Any text
Key_3=french
IniReadPos,%Var%,C:\Lang.ini,Section,count
Allocates to variable %Var% the value 3 (number of defined INI lines)

Back to Table of Contents

IniRenameSection
Renames an existing section inside an INI file

Syntax:
IniRenameSection,<File>,<0OldSection>,<NewSection>

Example:
IniRenameSection,C:\MyFile.ini,Section_1,Section_2
Renames Section_1 to Section_2.

Back to Table of Contents
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2.3.3. Interface Processing

Interface,Get
Reads the value of an Interface element

Syntax:
Interface,Get,<Element>,<%Variable%>

Supported Element Types - pTextBox
pScrollBox
pCheckBox
pFileBox
pTextLabel

The element types can also be defined as variables

Example:
[Interface]
pCheckbox1=True,Checkbox,0,<Any_Section>,50,80,120,18

[Process]
Interface,Get,pCheckBox1,%Var%
Allocates to variable %Var% the value True .

Back to Table of Contents

Interface,Set
Sets the value of an Interface element

Syntax:
Interface,Set,<Element>,<Value>

Supported Element Types - pTextBox
pScrollBox
pCheckBox
pFileBox
pTextLabel

The element types can also be defined as variables

Examples:
[Interface]
pCheckbox1=True,Checkbox,0,<Any_Section>,50,80,120,18

[Process]
Interface,Set,pCheckBox1,False
Allocates to pCheckBox1 the value False .

Set,%RowCount%,10

Set,%Value%, Test
Interface,Set,pTextlabel%RowCount%,%Value%
Allocates to pTextlabell0 the text Test .

Back to Table of Contents

Interface,State

Changes the attribut of an Interface element
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2.4.

Syntax:
Interface,State,<Element>,<Parameter>

Supported Element Types - pTextBox
pScrollBox
pCheckBox
pFileBox
pTextLabel

The element types can also be defined as variables

Parameter: - hide / show

Example:

Interface,State,pScrollBox1,hide
Hides the element pScrollBox1 inside the Interface

Back to Table of Contents

Interface,Update
Updates the value of an Interface element

Syntax:
Interface,Update,<Element>

Example:
IniWrite,%ScriptFile%,Interface.07,pScrollBox2,Test,1,0,0,100,190,60,20,Vall,Val2, Test
Interface,Update,pScrollBox2

Updates the element pScrollBox2 in Interface.07 with value Test .

Back to Table of Contents

Registry Processing

To handle the PE Registry the Registry Hives must be loaded, elaborated and after that
unloaded.

Loadhive
Loads an external Registry Hive into the locale Registry of your system.

Syntax:
Loadhive,<HivePath>,<RegistryRoot>

Hivepath - Path to Hive file

RegistryRoot - PE-SYSTEM HKLM/SYSTEM
PE-SOFTWARE HKLM/SOFTWARE
PE-USER HKCU/Software
PE-COMPONENTS HKLM/COMPONENTS

Examples (Multi7PE_SE + Win8PE):

Loadhive,%target_sys%\config\system,PE-SYSTEM
Loadhive,%target_sys%\config\software,PE-SOFTWARE
Loadhive,%target_sys%\config\default,PE-USER up to Win8
Loadhive,%TargetDir%\Users\Defaul\NTUSER.DAT,PE-USER beginning with Win8.1
Loadhive,%target_sys%\config\components,PE-COMPONENTS

Examples (WinXP PE):
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Loadhive,%target_sys%\setupreg.hiv,PE-SYSTEM
Loadhive,%target_sys%\CONFIG\SOFTWARE,PE-SOFTWARE
Loadhive,%target_sys%\CONFIG\DEFAULT,PE-USER

Note:

By default HKLM\COMPONENTS will not be shown in the PE Registry.
To view this hive the following procedure is necessary:

BN S

Back to Table of Contents

UnLoadhive
Unloads the external Registry Hive

Syntax:

Open the Registry Editor of running PE

Click on the hive HKEY_LOCAL_MACHINE

In menu “File” choose Load Hive

Choose path X:\Windows\System32\config\components and click on OPEN
In the appearing window LOAD HIVE enter COMPONENTS
HKLM\COMPONENTS is now available

UnLoadhive,<RegistryRoot>

Example:
UnLoadhive,PE-SYSTEM

Back to Table of Contents

RegRead

Reads a Registry Key

Syntax:

RegRead,<%Variable%>,<HKEY>,<Key><Value>

Example:

RegRead,%Var%,HKLM,SOFTWARE\7-zip,Path
Allocates to variable %Var% the value of Path (=C:\Program Files\7-zip)

Using REG_MULTI_SZ (0x7) delimiter will be interpreted as #$x (Carriage Return)

Back to Table of Contents

RegWrite
Creates or changes a Registry Key

Syntax:

RegWrite,<HKEY>,<Type>,<Key>,[ValueName],[Value]

Type - 0x0 empty key with entry (Standard)
0x1 REG_SZ writes a text
0x2 REG_EXPAND expanded variable in writing style %%
0x3 REG_BINARY writes a binary value
0x4 REG_DWORD writes a numeric value
0x7 REG_MULTI_SZ writes multiple strings separated by #$x
Key - Name of the key
Valuename - optional name of the value
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Value - optional value

Extended notation of Variables

Set,%var%,01,a2,03
RegWrite,HKLM,0x3,PE-SOFTWARE\Software, Test,%var%

Set,%var%,01,02,03
RegWrite,HKLM,0x3,PE-SOFTWARE\Software, Test,%var%,04,aa,05

Extended notation of REG_MULTI_SZ (0x7):
used delimiter is #$x

Set,%Var%,10#$x20
RegWrite,HKLM,0x7,SOFTWARE\MyKey,Key0x7,%Var%,30,40
32-bit system:
Writes in REGKey SOFTWARE\MyKey the character string KeyOx7 with following values
10 20 30 40
64-bit system:
Writes in REGKey SOFTWARE\Wow6432Node\MyKey the character string KeyOx7
with following values 10 20 30 40

Empty Multistring entries will get skipped

Examples:

RegWrite,HKLM,0x4,PE-SYSTEM\ControlSet001\Services\MpsSvc, Start,3

Writes into the PE Registry in HKLM\SYSTEM\ControlSet001\Services\MpsSvc the valuename
Start with a numeric value 3.

RegWrite,HKLM,0x0,PE-USER\Software\Microsoft\Windows\CurrentVersion\MyRegKey
Writes into the PE Registry in HKCU\Software\Microsoft\Windows\CurrentVersion the new
key MyRegKey with string (Standard) and the type REG_SZ as well as in array Data

the value (Value not set).

Set,%var%,01,a2,03

RegWrite,HKLM,0x3,PE-SOFTWARE\Software, Test,%var%

Writes into the PE Registry in HKLM\Software the valuename Test with a binary value
01,a2,03.

Set,%var%,01,02,03

RegWrite,HKLM,0x3,PE-SOFTWARE\Software, Test,%var%,04,aa,05

Writes into the PE Registry in HKLM\Software the valuename Test with a binary value
01,02,03,04,aa,05.

Advice to Type 0x4:
Decimal notation is possible as well as hexadecimal notation

Back to Table of Contents

RegDelete
Deletes a Registry Key

Syntax:

RegDelete,<HKEY>,<Section>,[ValueName]

Examples:
RegDelete,HKLM,PE-SYSTEM\ControlSet001\Contro\ComputerName\ComputerName,ComputerName
Deletes in the mentioned Registry Key the valuename ComputerName.

RegDelete,HKLM,PE-SYSTEM\Test
Deletes in the mentioned Registry Key the valuename (Standard).
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2.5.

Back to Table of Contents

String

String

Processing

LEFT/RIGHT

Checks the specified number of characters in strings

Syntax:
String,<%Variable%>,<Action>,<String>,<Counter>

Action - Left Number of characters in a string, beginning from the left
Right Number of characters in a string, beginning from the right

Counter - Number of characters

Examples:

Set,%String%,Sommerurlaub
String,%var%,Left,%String%,6
Allocates to variable %var% the value Sommer .

Set,%String%,Sommerurlaub
String,%var%,Right,%String%,6
Allocates to variable %var% the value urlaub .

Back to Table of Contents

String

TLeft/TRight

Trims any characters of a string

Syntax:
String,<%Variable%>,<Action>,<String>,<Counter>

Action - TLeft

Trims characters of a string, beginning from the left

TRight Trims characters of a string, beginning from the right

Examples:

Set,%String%,Hallo

String,%Var%, TLeft,%String%,1

Allocates to variable %Var% the value allo .

Set,%String%,Hallo
String,%Var%, TRight,%String%, 1
Allocates to variable %Var% the value Hall .

Back to Table of Contents

String

TIME

Checks the current system time

Syntax:
String,<%Variable%>, TIME,<Parameter>

Parameter - Hour
Minute
Second
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Example:
String,%Var%,TIME,Hour
Allocates to variable %Var% the value of the current hour (in 24 digit format).

Back to Table of Contents

String FIND

Shows the first position of a substring in a specified string

Syntax:
String,<%Variable%>,FIND,<String>,<SubString>

Example:

Set,%String_1%,Sommerurlaub

Set,%String_2%,url

String,%Var%,FIND,%String_1%,%String_2%

Allocates to variable %Var% the position (7) of correlation of charu .

Note:
If there is no correlation the position has always a value of 0

Back to Table of Contents

String LEN

Determines the length of a string

Syntax:

String,<%Variable%>,LEN,<String>

Example:

String,%Var%,LEN, Teststring

Allocates to Variable %Var% the length (10) of string Teststring .

Back to Table of Contents

String MID

Trims any part of a string

Syntax:
String,<%Variable%>,MID,<String>,<Position>,<Counter>

Example:

Set,%String%,Sommerurlaub
String,%Var%,MID,%String%,2,4

Allocates to variable %Var% the value omme .

Back to Table of Contents

String REPLACE

Replaces a part of a string by another part

Syntax:

String,<%Variable%>,REPLACE,<Searchstring>,<Replacestring>,[Parameter]
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2.6.

Parameter - 0 (default) Disbandment of variables
1 Disbandment of variables up to level 1
(1*" variable in variable)

Example:
Set,%String%, The quick brown fox jumps over the lazy dog
Set,%Searchstring%,brown
Set,%Replacestring%,black
String,%Var%,REPLACE,%String%,%Searchstring%,%Replacestring%
Allocates to variable %Var% the new string

The quick black fox jumps over the lazy dog

Back to Table of Contents

String SPLIT
Splits a string

Syntax:
String,<%Result%>,SPLIT,<%Variable%>,<Delimiter>,<Parameter>

Parameter =0 - Number of items of %Variable%
Parameter >0 - Returns the substring of %Variable% of indicated
Index
Example:

RegRead,%Var%,HKLM,SYSTEM\CurrentControlSet\Services\NetBIOS\Linkage,Bind
String,%Count%,SPLIT,%Var%,#$x,0
For,%x%,1,%Count%

String,%Res%,SPLIT,%Var%,#$x,%x%

Message,%Res%=%x%
Next
Allocates to Variable %Var% the content of character string Bind in above mentioned REGKey,
while Variable %Count% contents the number of found arrays.
In the following For/Next Loop the content of Variable %Var% will be split on the basis of the
particular parameters and allocated in each loop to Variable %Res% .

Back to Table of Contents

Network Commands

WebGet

Loads a file from the internet

Syntax:
WebGet,<Filelninternet>,<PathToStore>,[Parameter]

Parameter - 1 shows a progress bar
2 loads a file of unknown size

Examples:

Download without progress bar (http://)

WebGet, http://irfanview.tuwien.ac.at/iview433.zip,C:\iview433.zip

Loads the file iview433.zip from http://irfanview.tuwien.ac.at and stores it in C:\

Download without progress bar (ftp://)
WebGet,ftp://ftp.cpuid.com/cpu-z/cpu-z_1.61-32bits-en.zip,C:\ cpu-z_1.61-32bits-en.zip
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Loads the file cpu-z_1.61-32bits-en.zip from ftp.cpuid.com and stores it in C:\

Download with progress bar
Webget,ftp://wa651f4:anonymous@mh-nexus.de/HxDSetupDE.zip,C:\HxDSetupDE.zip,1
Loads the file HxDSetupDE.zip and shows a progress bar

Download a file of unknown size and progress bar
Webget,http://googledrive.com.../Firefox_36.0.4.zip,C:\Firefox.zip,3
Loads the file of unknown size Firefox_36.0.4.zip and shows a progress bar

WebGet has available a return variable %Exitcode%:
0 - Ok
1 - Error

Example:

System,Error,Off
WebGet,http://www.a43filemanager.com/download/a43.zip,c:\a43.zip,1
Message,Download: %Exitcode%

System,Error,on

Note:

Using the WebGet Parameter 3 (addition from 1 and 2) %Exitcode% is not
necessary.

Usage of FTP Downloads with Password:

Example:
WebGet,ftp://wa651f4:anonymous@mh-nexus.de/HxDSetupDE.zip,C:\HxDSetupDE.zip,1

Back to Table of Contents

2.7. Loop commands

2.7.1. For / Next - loop

Runs a command repeatedly

Syntax:

For,<%Variable%>, <Start>,<End>
<Command>

Next

Start Initial value
End Final value

Example:
For,%Var%,1,5
Message,Loop: %Var%
Next
This loop will be executed five times whereas the values of %Var% are changing each time,
showng the following messages:
Loop: 1
Loop: 2
Loop: 3
Loop: 4
Loop: 5

Back to Table of Contents
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http://www.a43filemanager.com/download/a43.zip,c:%5Ca43.zip,1

2.7.2.

2.8.

ExitLo

op

Quits a For/Next Loop

Syntax:

ExitLoop

Example for recursive loop:
If,a,=,a,then

Else

End

Message,End of Loop

[Load-D]

Message,sub %x%,#1

For,%x%,1,6

if,a,=,a,then

Else

End

Run,%ScriptFile%,Load-D,mouclass.sys
if, %x%,=,4,then,ExitLoop

Message,Message window without window title

Message,Loop: %x%

Next

Message, Test 1

In this example a message window appears with window title mouclass.sys and the

message subl, afterwards a message window appears without window title and the message
Loop: 1, afterwards a message window appears with window title mouclass.sys and

the message sub?2. This process repeats itself until a message window with window title
sub4, afterwards a message window appears without window title and the message

End of Loop

Back to Table of Contents

Variables (in

tern)

These variables will be set by the Builder on StartUp

%BaseDir%
%CPUVM%

%Day%
%ExitCode%
%HostAdmin%

%HostArch%
%HostLang%
%HOStNT%
%HostOS%

%ISODir%
%ISOfile%
%ISOFilename%
%Month%
%ProcessError%

%ProcessMode%

Root directory (e.g.: C:\LiveSystempro)

checks if the processor is capable for Virtualization Technology (VT-x)
0: not capable

1: capable

current day

Exit code

User’s administrator rights

0: No administrator right
1: Administrator right
Architecture of Host

Locale ID (hexadecimal)

NT version of Host

Operating system of Host
(WinXP, Win2003, WinVista, Win7, Win8)
(e.g.: Y%BaseDir%\Iso)

(e.g.: %BaseDir%\Iso\winpe3.iso)

(x86, x64)
(07, 09, ...)
(5.1,5.2, 6.0, ...)

Path to ISO directory
Path to ISO file
Name of ISO file
current month

0: No error
3: Halt
4. Error

(will be set in %Projectini%,[ONBUILDEXIT] only)
Process mode

0: Button ,Start”

1: Button ,>*

Seite 32 von 40



%ProgramFilesDir%
%Programs64%
%ProjectDir%
%ProjectFolder%
%Projectini%
%ProjectName%
%ScriptDir%
%ScriptFile%
%ScriptLvi%
%SourceDir%
%TargetDir%
%TempDir%

%UserName%
%UserProfile%
%WindowsDir%
%WinUAC%

%YEAR%

2: Interface Element [Section]

Program directory (e.g.: C:\Program Files)

64-bit program directory

Path to Project directory  (%BaseDir%)\Projects\<Project>)
Directory name of project (Multi7TPE_SE, WIn8PE, WinXPE)
Project file (%BaseDir%\Projects\<Project>\project.cfg)
Project name (Multi7PE_SE, Win8PE, WinXPE)
Folder with current scriptfile

current scriptfile

Script level

Source directory on installation media

Target directory (e.g.: Y%BaseDir%\Target\Multi7PE_SE)
Path to User’s Temp directory

(e.g.: C:\Users\<Username>\AppData\Local\Temp)

Username

Path to Home directory (e.g.: C:\Users\<Username>)
Path to Windows directory (e.g.: C:\Windows)

User Account Control (from Windows Vista onwards)

Value 0/1

current year

back to Table of Contents

Variables (Project)

Multi7PE_SE and Win8PE:
%B00tSRC% -

%boot_sys%

%boot_win%

%boot_wow%

%CDDrive%
%DistLang%
%InstallSRC%

%Install_sys%

%lInstall_win%

%Install_wow%

%lnstallwim%
%ISOfile%
%PECFG%
%PE_programs%
%ProjectTemp%
%prog_files%
%Ramboot%
%RamDrive%
%SourceEdition%
%target_sys%
%target_win%
%target_wow%
%WIM_ARCH%
%Wim_Bootldx%
%WIM_BUILD%
%WIM_Index%

Boot source (decompressed file boot.wim)

e.g.: %BaseDir%\Wim\Win7SP0de-DE-B\2

System32 directory of %BootSRC%

e.g.:

%BaseDir%\Wim\Win7x86SP0de-DE-B\2\Windows\system32
Windows directory of %BootSRC%

e.g.: %BaseDir%\Wim\Win7x86SP0de-DE-B\2\Windows

SysWow64 directory in %BootSRC% (64-bit media only)

e.g.

%BaseDir%\Wim\Win7x86SP0de-DE-B\2\Windows\SysWowW64

Drive Y:

Language of source media

Install source (decompressed file install.wim)

e.g.: %BaseDir%\Wim\Win7-Enterprisex86SP0de-DE-I

System32 directory of %InstallSRC%

e.g.
%BaseDir%\Wim\Win7Enterprisex86SP0de-DE-I\Windows\System32
Windows directory of %lInstallSRC%

e.g.

%BaseDir%\Wim\Win7Enterprisex86SP0de-DE-I\Windows
SysWoW64 directory in %lInstallSRC% (64-bit media only)

e.g.:
%BaseDir%\Wim\Win7Enterprisex64SP0de-DE-\Windows\SysWoW 64
Path to image file (Install.wim / Install.esd) (Project Win8PE only)
e.g.: %BaseDir%\ISO\WIn8[SP0]-de_DE_x86.iso
%TargetDir%\Windows\System32\win7pe.cfg

either X:\%prog_files% or Y:\%prog_files%

Temporary project directory (%BaseDir%\Temp\Multi7PE_SE)
Program Files

True/False

Drive X:

Edition of Windows Source
System Target directory
Windows Target directory
SysWoW64 Target directory
Image Architecture

Image Index of boot.wim
Part of Microsoft file version
Image Index

(% TargetDir%\Windows\System32)
(% TargetDir%\Windows)
(% TargetDir%\Windows\SysWoW64)

(e.g.: 7600 bei ,6.1.7600.16385)
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%WIM_MAJOR%
%WIM_MINOR%
%WIM_SPBUILD%
%WIM_SPLEVEL%

WinXP PE:
%administrator%
%admin_tools%
%all_users%
%app_data%
%Basescripts%
%cookies%
%common_files%
%desktop%
%doc_and_sett%
%docs%
%drCabFile%
%favorites%
%history%
%ISOfile%
%Keyboard%
%LangID%
%LangGroup%
%local_sett%
%LCID%
%ms_ie_quicklaunch%
%mydocs%
%OEMCP%
%PE_Programs%
%prog_files%
%Ramboot%
%RambDrive%
%sendto%
%source_sys%
%source_win%
%SPCabFile%
%startmenu%
%startmenu_prog%

%startmenu_prog_startup% -

Y%startup%
%target_sys%
%target_win%
%templates%
%temp_internet_files%

Common Variables:

%Arch%
%LSPVer%
%NT%

%NTVersion%
%0S%

%ProjectTemp% -
%Target_ CD%
%Target_Prog%
%Tools%

Part of Microsoft file version
Part of Microsoft file version
Part of Microsoft file version
ServicePack Version

(e.g.: 6 bei ,6.1.7600.16385)
(e.g.: 1 bei ,6.1.7600.16385')
(e.g.: 16385 bei ,6.1.7600.16385")

Administrator

Computer Management

All Users

Application Data
%BaseDir%\Projects\%ProjectName%
Cookies

Common Files

Desktop

Documents and Settings
Documents

Compressed driver file (in CAB format)
Favorites

History
%BaseDir%\ISO\WinXPE.iso
Keyboard settings

Language of source media
Language Group

Locale Settings

Locale ID

Microsoft\Internet Explorer\Quick Launch
My Documents

Code Page
%Systemdrive%\%prog_files%
Programs

True/False

Drive B:

SendTo
%SourceDir%\I1386\System32
%SourceDir%\I1386

Version of ServicePack cabinet file
Start menu

Start menu\Programs

Start menu\Programs\Autostart
Autostart
%TargetDir%\I386\System32
%TargetDir%\I386

Templates

Temporary Internet Files

Architecture of Source (x86, x64)

Version number of LiveSyspro.exe

NT Version of Source

5.1 Windows XP

5.2 Windows XP Professional x64, Server 2003
6.0 Windows Vista, Server 2008

6.1 Windows 7, Server 2008 R2

6.2 Windows 8

6.3 Windows 8.1

NT Version of Source (5, 6)

Operating system of Source

(WinXP, Win2003, WinVista, Win7, Win8)

Temporary Project directory (e.g.: %BaseDir%\Temp\WinXPE)
Target directory (%TargetDir%_CD)
%TargetDir%\%prog_files%

Tools directory (%BaseDir%\Tools)
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%PreUserdata% - %BaseDir%\Temp\%ProjectName%\UserData
%SP% - Version number of ServicePack

Back to Table of Contents

2.10. Special Characters

The following special chars will be used within LiveSystempro:

#ExX - Carriage Return + LineFeed
#$q - Quotation marks ( )

#$c - Comma

#$p - Percent sign (%)

#$s - Blank space

#%d - Pipe (])

Back to Table of Contents

2.11. Shortcuts

Syntax:
Add_Shortcut,[Type],[StartMenuFolder],[FullFileName],[Title],[Workfolder],[Parameters],[IconFile]

Type - StartMenu
Desktop
Quicklaunch
StartMenuFolder - a. Special name for “Folder\Subfolder”

b. “.” For a shortcut in StartMenu\Programms
c. Empty field is also possible

FullFileName - Only necessary if shortcut is different to
%ProgramExe%.
Default: %Pe_Programs%\%ProgramFolder%\%ProgramExe%

Title - Any title
Default: %ProgramTitle%
Workfolder - Any work folder
Parameters - To start %ProgramExe% with parameters
IconFile - Only necessary using a special icon for shortcut
Examples:

Add_Shortcut,Desktop
Creates a shortcut of the program to run on the Desktop.

Add_Shortcut,StartMenu,%pTextBox1%
Creates a shortcut of the content of %pTextBox1% with the StartMenu.

Add_Shortcut,StartMenu,.,MyProgramgXE,,,,
Creates a shortcut of the program to run in StartMenu\Programs (No Subfolder).

Add_Shortcut,StartMenu,.,MyProgramEXE, ,,,.exe.ico#$c7
Creates a shortcut of the program to run in Startment\Programme with icon #7 of the
EXE file.

Add_Shortcut,StartMenu,MyFolder\MySubfolder,MyProgramgXE,,,,
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Creates the folder MyFolder\MySubfolder in StartMenu\Programs, within this folder
MyProgramEXE will be placed.

Add_Shortcut,Desktop,,,IrfanView Thumbnails,,/thumbs,%PE_Programs%\%ProgramFolder%\Thumbnails.ico

Creates a shortcut of IrfanView Thumbnails on the Desktop.
Start parameter for %ProgramExe% is /thumbs, shows the icon of file Thumbnails.ico

Back to Table of Contents

2.12. Macros

e  Macros provide the possibility to execute often used commands automatically
(compare command SetMacro).
e  Certain files (not all are needed) are decompressed by PreConfig from the source and put into the Wim cache.
These are 2 separate Wim subdirectories (boot.wim and install.wim)
The macros work with these 2 Wim caches.
Exceptions:
Add_Shortcut and RunFromRam (all Projects)
CopyDesktoplni (WIin8PE)
e Macros will be stored in %Projectini% [Macros] .
e Fallback en-US:
an English mui file will only be copied if %Distlang% mui does not exist.
If there are no matching mui files none will be copied. A missing mui file will never give an error!

Note:
The LSP projects use different macros.

Multi7PE_SE + WIin8PE + WinXPE:
Add_ShortCut

Creates shortcuts of programs (compare section 2.11)

RunFromRAM,<Value>

Value - False | True
Regulates program execution in RAM or from CD
Examples:

RunFromRAM,False

The program (=%PE_programs%) will run from CD  (Drive Y:)
RunFromRAM, True

The program (=%PE_programs%) will run in RAM  (Drive X:)

Multi7PE_SE + WIin8PE:

FileDecBoot

Unpacks files from boot.wim to %BootSRC%

Example:

FileDecBoot,Windows\System32\Wbem\%DistLang%\Msi.mfl

Extracts the file Msi.mfl to e.g..:
%BaseDir%\Wim\Win7SP0de-DE-B\2\Windows\System32\Wbem\%DistLang%

FileDeclnst

Unpacks files from install.wim to %lInstallSRC%

Example:

FileDeclInst,Windows\System32\Wbem\*.*

Extracts all files to e.g.:
%BaseDir%\Wim\Win7Enterprisex86SP0de-DE-\Windows\System32\Wbem

ReqSys32,<File>
File - File in System32 directory (Install Wim Cache) to copy + mui (fallback en-US)
Example:
RegSys32,mapi32.dll
Copies mapi32.dll to Windows/System32
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Copies mapi32.dll.mui to Windows/System32\%DistLang%
Wildcards are not supported.
Gives an error if the file does not exist.

ReqB32,<File>
File - File in System32 directory (Boot Wim Cache) to copy + mui (fallback en-US)
Example:
ReqB32,attrib.exe
Copies attrib.exe to Windows/System32
Copies attrib.exe.mui to Windows/System32\%DistLang%
Wildcards are not supported.
Gives an error if the file does not exist.

ReqSysWoW64,<File>
File - File in SysWow64 directory (Install Wim Cache) to copy + mui (fallback en-US)
Example:
RegSysWoW64,activeds.dll
Copies the 32-bit file activeds.dll to Windows\SysWoW64
Copies the 32-hit file activeds.dll.mui to Windows\SysWoW64\%DistLang%
Wildcards are not supported.
Gives an error if the file does not exist.

ReqWin,<File>
File - File in Windows directory (Install Wim Cache) to copy + mui (fallback en-US)
Example:
RegWin,explorer.exe
This will copy explorer.exe to Windows.
This will copy explorer.exe.mui to Windows\%DistLang%.
Wildcards are not supported.
Gives an error if the file does not exist.

Back to Table of Contents

3. Script Control

3.1. Standard Sections of Scripts

Normally scripts are structured in these sections
[Main]
[Interface]
[Process]

Creation of additional necessary sections is always possible.

Back to Table of Contents

3.1.1. Section [Main]

Preferentially these entries should exist:

[Main]

Title= Program title

Description= Short description of program

Selected= true Script is enabled in tree view of interface
False Script is disabled in tree view of interface
None Script will be executed, cannot be checked or unchecked
Noprocess Script will be shown but not executed

Level= Script level in tree view of LiveSystem pro
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- Build

- Shells

- Components
Customize + Drivers
- Apps

- Finish

- Utils + Virtual Test
Author= Name of script author

Version= Progressive script version number
Date= Date of creation or update date

OOoOUThA,WNPE
l

Entries in section [Main] to control other scripts:
Disable= Xyz.srt Script will get disabled
Enable= Xyz.srt Script will get enabled

Back to Table of Contents

3.1.2. Section [Interface]

In this section happens the optical illustration of needed texts and checkboxes.
Selection of checkboxes happens by clicking button | (see image):

‘{!D LiveStem pro
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MusTPE_SE
) MATPE_SE
- Buid
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e MMC . El
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i Raecovasy Took WinT ] Device Marager
A v Morosofl Wiosdpad e
| %0 PENetwods VOLSEET) o] Dk Marcagermerd
| (] Aem Basic Theme i
e Custors
Detvas
]
Firish

; Liis
NI E Wiriusl Test

cl-._lq:;iig

s

I SImpot @) Log U Hife

Creation of multilingual interfaces

Additional interfaces can always get included according to this example:

[Interface] english texts and checkboxes
[Interface.07] german texts and checkboxes
[Interface.13] dutch texts and checkboxes

The builder will use automatically the rigth version.

Back to Table of Contents
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3.1.3. Section [Process]

In this section all necessary commands have to take place to run a program.

Back to Table of Contents

3.2. Active Script Control

Some interface checkboxes can be used to make specific changes to the display of entries.

3.2.1. Choosing Windows Source

= ' \ - S = )
'E!D LiveSyrttem pro :
 Projekt:
wae st . w1 @CI
i) MATPE_SE
| Ju = - Preconfig E| |1
i ;m }m. Geting some nfo . preparng and decomp g sumE T F
(o " Easefiss edm
i .. g Corfis v.14 E
i | W Basc E
'] | Shels
IJ £ | Comporenis s
w- | Cusbomize B
e | Drvesy 9
[ £ e [ 3] ,
f Firish Windows Index | 1 W7 Enterprise (64 5P0 de-[iE) "’l I_H.rrun I 1
. L
Wirtusl Tas
1
|
:ﬁ i mio S Impoit @ Log R Hife O s
Before running the first build
Click on button 1: Result: 4: Display of source path
2: Display of Windows version

Before running an additional build using another Windows source
Click on button 3: Result: 2: Display of Windows version

Back to Table of Contents

3.2.2. Script-Select

Used to update boxes (example of an originally empty Scrollbox)
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VirlualBox Emulation
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WirtualBox has to be installed on your HDD

Allocated memany (MB) M2 w

Baotiso. | WndfSP0| deDE xdbno o |

1add Metwork

Cladd Audie ICH ACST

Example code:
[Interface.07]
pScrollBox3=,1,0,0,20,270,215,20

[Script-Select]
search,%Var%,File,%ISODir%,*.iso
Interface,set,pScrollBox3,%Var%

Result:
- Choosing the script in the tree view the Scrollbox gets updated
- pScrollBox3 gets updated:
[Interface.07]
pScroliBox3=Win7[SP0]_de-DE_x86.is0,1,0,0,20,270,215,20,Win7[SP0]_de-DE_x86.iso

Back to Table of Contents
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